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Windows XP Home Edition Tips 
Learn quick ways to get the most out of Windows XP Home Edition. 

Get Started 

Get Back to the Desktop Quickly 

No matter how many windows you have open, you can always minimize all of them at 
once by clicking the Show Desktop button in the Quick Launch part of the taskbar in 
Windows XP.  If you change your mind and don't want to use the desktop, you can click 
the Show Desktop button again to restore all of your windows.  

Another way to accomplish the same thing is to hold down the < > key while pressing 
the M key.  This will minimize all open windows.  To restore them, hold down the 
<Shift> and < > keys while pressing the M key. 

Note:  If you don't see the Show Desktop button, right–click an empty part of the taskbar, 
point to Toolbars, and make sure Quick Launch is checked.  If it’s not, then click it. 

Move or Copy Files to Subfolders 

You can use My Computer in Windows XP to move or copy a file by dragging the file 
icon to a folder.  When you have Folders displayed on the left side of the window, it's 
easy to drag a file to a different folder. 

If the folder you want isn't visible because the folder it's in is not expanded, here's a trick 
that will save you time and frustration.  Drag the file icon to the collapsed (unexpanded) 
folder, and hold it there for a few seconds.  The folder automatically expands and then 
you can drop the file into the folder you want. 

Ways to Delete a File or Folder 

When folders and files start to clutter up your hard disk, Windows XP gives you several 
ways to get rid of the files and folders you don't want. 

Within My Computer, you can use any of these methods: 

• Right–click the file or folder, and then click Delete.  
• Select the file or folder, and then press the <Delete> key.  
• Select the file or folder, click the File menu, and then click Delete.  
• Drag the file or folder to the Recycle Bin on the desktop.  
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Note:  To access My computer, click on Start, and then click My Computer.  You can 
also use the hotkey, < >E. 

Move Backward and Forward Between Web Pages More Quickly 

In Internet Explorer 6 in Windows XP, you can click the Back and Forward buttons to 
move back and forth between pages you've recently viewed, one page at a time.  If you 
want to go back several pages and forward again more quickly, click the small black 
arrow next to the Back and Forward buttons to see a list of pages you've recently 
viewed—and then just click the page you want.  You can also display this list by right–
clicking the Back or Forward buttons. 

Find Your Way Back to a Web Page You Saw Some Time Ago 

To find a page that you visited days, weeks, or even months ago, but which you never 
added to your Favorites, you can use the History list in Internet Explorer 6 in Windows 
XP to help track it down.  Click the History button on the toolbar.  The History bar 
appears, containing shortcuts to every page you've been to today, yesterday, the day 
before, and so on for the previous three weeks.  The links are organized by week.  To find 
the link you want, click the week that you believe you saw it.  Links in each week’s 
groupings are listed alphabetically. 

Note:  You can change the number of days that pages are saved in the History list (click 
Tools, then click Internet Option, and then look for the History section of the General 
tab). The more days you specify, the more disk space is used on your computer to save 
that information. 

Rearrange and Resize Toolbars in Internet Explorer 

With Internet Explorer 6 in Windows XP, you can move your menu bar, toolbar, Links 
bar, and Address bar to create more room to view Web pages or to customize your 
browser for efficiency's sake. 

Simply point to the vertical bar on the left side of the bar you want to move.  When the 
pointer changes to a double–headed arrow, drag the toolbar to where you want it.  You 
can move it left, right, up, or down. 

Are You Linked to a Workgroup? 

To determine whether your computer is linked to a workgroup. 

1. Click Start.  
2. Right-click My Computer.  
3. Click Properties from the drop-down menu that appears.  
4. Click the Computer Name tab. 
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Are You on a Domain? 

To determine whether your computer is linked to a domain: 

1. Click Start.  
2. Right-click My Computer.  
3. Click Properties from the drop-down menu that appears.  
4. Click the Computer Name tab. 

Files and Settings Transfer Wizard 

Using the Files and Settings Transfer Wizard 

The Files and Settings Transfer Wizard helps you move your data files and personal 
settings from your old computer to your new one, without having to repeat much of the 
same configuration you did with your old computer.  For example, you can take your 
personal display properties, folder and taskbar options, and Internet browser and mail 
settings from your old computer and place them on the new one.  The wizard will also 
move specific files or entire folders, such as My Documents, My Pictures, and 
Favorites. 

To access the Files and Settings Transfer Wizard 

To open the Files and Settings Transfer Wizard, click Start, point to All Programs, point 
to Accessories, point to System Tools, and then click Files and Settings Transfer 
Wizard. 

Going Solo? 

If you're a party of one—sole owner and user of a computer—you might still want to set 
up your computer with user accounts, naming you as computer administrator and 
protecting the account with a password.  Doing so prevents casual access to the system by 
others if you leave your computer unattended while logged onto Windows XP, provided 
you log off from your account. 

For added security, disable guest access. Here's how: 

1. Click Start, and then click Control Panel.  
2. Click User Accounts.  
3. Click Change an account, then click Guest.  
4. On the What do you want to change about the guest account page, click 

Turn off the guest account.  
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Note for Windows XP Professional Users 

This description and procedure applies only to users of Windows XP Home Edition and 
to users of Windows XP Professional configured to link the computer to a workgroup.  If 
your version of Windows XP Professional links the computer to a domain, see your 
network administrator or visit Help and Support Center and search for “user accounts”. 

Personalize Your Computer 

Add a Shortcut to Your Desktop 

A quick way to open files or folders or start your programs is to place a shortcut icon on 
the desktop.  Here’s how: 

To place a shortcut icon on the desktop 

1. Right-click Start, and then click Explore.  
2. Locate the folder, file, or program, and then right-click the item and drag it to 

your Desktop.  
3. Release the right mouse button to get a context sensitive menu.  
4. Click Create Shortcut Here.  

Display the Quick Launch Bar 

If you have opened more than one program, you might like to display and use the Quick 
Launch bar.  The Quick Launch bar makes it easy to access frequently used programs like 
Windows Media Player and your E-Mail, and to open an Internet Explorer window.  
Windows XP loads several programs in the Quick Launch, including Show Desktop.  
One click on Show Desktop minimizes all the programs on your desktop.  Another click 
restores them just as you'd left them.  

To display Quick Launch on the taskbar 

1. If the Quick Launch bar is not displayed, right-click an empty area of the 
taskbar and point to Toolbars and then click on Quick Launch.  

After Quick Launch is displayed, click Show Desktop to minimize all open programs. 

Keyboard Shortcuts 

When speed counts, the keyboard is still king.  Almost all the actions and commands you 
can perform with a mouse you can perform faster using combinations of keys on your 
keyboard.  These simple keyboard shortcuts can get you where you want to go faster than 
several clicks of a mouse.  You'll work faster on spreadsheets and similar documents, too, 
because you won't lose your place switching back and forth between mouse and keys. 
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Here are some of the most useful keyboard shortcuts: 

To Press 

Copy. <Ctrl>C 

Cut. <Ctrl>X 

Paste. <Ctrl>V 

Undo. <Ctrl>Z 

Delete. <Delete> 

Delete selected item permanently without 
placing the item in the Recycle Bin. 

<Shift><Delete> 

Copy selected item. <Ctrl> while dragging an item 

Create shortcut to selected item. <Ctrl><Shift> while dragging an 
item 

Rename selected item. <F2> 

Move the insertion point to the beginning of 
the next word. 

<Ctrl><Right arrow> 

Move the insertion point to the beginning of 
the previous word. 

<Ctrl><Left arrow> 

Move the insertion point to the beginning of 
the next paragraph. 

<Ctrl><Down arrow> 

Move the insertion point to the beginning of 
the previous paragraph. 

<Ctrl><Up arrow> 

Highlight a block of text. <Ctrl><Shift> with any of the 
arrow keys 

Select more than one item in a window or on 
the desktop, or select text within a 
document. 

<Shift> with any of the arrow keys 

Select all. <Ctrl>A 

Search for a file or folder. <F3> 

View properties for the selected item. <Alt><Enter> 

Close the active item, or quit the active 
program. 

<Alt><F4> 
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Close the active document in programs that 
allow you to have multiple documents open 
simultaneously. 

<Ctrl><F4> 

Switch between open windows. <Alt><Tab> 

Cycle through items in the order they were 
opened. 

<Alt><Esc> 

Cycle through screen elements in a window 
or on the desktop. 

<F6> 

Display the Address bar list in My 
Computer. 

<F4> 

Display the shortcut menu for the selected 
item. 

<Shift><F10> Equivalent to right-
clicking on the item. 

Display the System menu for the active 
window. 

<Alt><Spacebar> 

Display the Start menu. <Ctrl><Esc> or press the 
<Windows> key 

Display the corresponding menu. <Alt> Underlined letter in a menu 
name 

Carry out the corresponding command. Underlined letter in a command name 
on an open menu 

Activate the menu bar in the active program. <F10> 

Open the next menu to the right, or open a 
submenu. 

<Right arrow> 

Open the next menu to the left, or close a 
submenu. 

<Left arrow> 

Refresh the active window. <F5> 

View the folder one level up in My 
Computer. 

<Backspace> 

Cancel the current task. <Esc> 

Prevent the CD from automatically playing. <Shift> when you insert a CD into the 
CD-ROM drive 

Use these keyboard shortcuts for dialog boxes: 
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To Press 

Move forward through tabs. <Ctrl><Tab> 

Move backward through tabs. <Ctrl><Shift><Tab>

Move forward through options. <Tab> 

Move backward through options. <Shift><Tab> 

Carry out the corresponding command or select the 
corresponding option. 

<Alt> Underlined letter 

Carry out the command for the active option or button. <Enter> 

Select or clear the check box if the active option is a check 
box. 

<Spacebar> 

Select a button if the active option is a group of option 
buttons. 

Arrow keys 

Display Help. <F1> 

Display the items in the active list. <F4> 

Open a folder one level up if a folder is selected in the Save 
As or Open dialog box. 

<Backspace> 

If you have a Microsoft Natural Keyboard, or any other compatible keyboard that 
includes the Windows logo key  and the Application key , you can use these 
keyboard shortcuts: 

To Press 

Display or hide the Start menu.  

Display the System Properties dialog box.  <Break> 

Show the desktop.  D 

Minimize all windows.  M 

Restores minimized windows.  <Shift>M

Open My Computer.  E 

Search for a file or folder.  F 

Search for computers. <Ctrl>  F

Display Windows Help.  <F1> 
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Lock your computer if you are connected to a network domain, or 
switch users if you are not connected to a network domain. 

 L 

Open the Run dialog box.  R 

Display the shortcut menu for the selected item.  

Open Utility Manager.  U 

Helpful accessibility keyboard shortcuts: 

To Press 

Switch FilterKeys on and off. Right <Shift> for eight seconds 

Switch High Contrast on and off. Left <Alt> left <Shift><Print screen> 

Switch MouseKeys on and off. Left <Alt> left <Shift><Num lock> 

Switch StickyKeys on and off. <Shift> five times 

Switch ToggleKeys on and off. <Num lock> for five seconds 

Open Utility Manager.  U 

Keyboard shortcuts you can use with Windows Explorer: 

To Press 

Display the bottom of the active window. <End> 

Display the top of the active window. <Home> 

Display all subfolders under the selected 
folder. 

<Num lock><Asterisk> on numeric 
keypad (*) 

Display the contents of the selected folder. <Num lock><plus sign> on 
numeric keypad (+) 

Collapse the selected folder. <Num lock><Minus sign> on 
numeric keypad (-) 

Collapse current selection if it's expanded, 
or select parent folder. 

<Left arrow> 

Display current selection if it's collapsed, or 
select first subfolder. 

<Right arrow> 

Notes: 
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• You must associate a password with your user account to secure it from 
unauthorized access.  If you do not have a password associated with your user 
account, pressing the +L will not prevent other users from accessing your account 
information.  

• Some keyboard shortcuts may not work if StickyKeys is turned on in Accessibility 
Options.  

• If you are connected to Windows through Microsoft Terminal Services Client, 
some shortcuts have changed.  For more information, see the online documentation 
for Terminal Services Client.  

Taskbar Taking Up Too Much Room? 

Is the Taskbar taking up too much room?  You can move it to any convenient location—
simply drag it to the sides, top or bottom of your screen!  You might need to unlock the 
taskbar first.  To do this, right-click any open area on the Taskbar, then click Lock the 
Taskbar to clear the check mark. 

Add Favorites with One Keystroke 

You can quickly add a Web page to your Favorites folder with a single keystroke.  The 
page is automatically added to your Favorites list without any further input from you. 

Press <Ctrl>D. 

Set Your Browser to Open to a Page of Your Choice 

Is there a site you always visit first when you browse the Web?  Would you like it to be 
the first site you see when you start Internet Explorer?  Just follow the steps below to 
change your home or “start” page. 

1. Navigate to the Web page you want to see when you start Internet Explorer.  
2. Click Tools on the menu bar, and then click Internet Options.  
3. In the Home page area, click Use Current. 

Make Sure Downloaded Files Are Easy to Find Later 

With Windows XP, it's easier than ever to download software updates, games, sounds, 
pictures—just about anything.  But sometimes it's hard to find them again on your hard 
disk.  To make sure you can, specify where you want a downloaded file to go. 

1. After you've indicated you want to download an item, a dialog box asks “What 
do you want to do with this file?” Select Save this program to disk.  

2. A dialog box opens where you can specify a folder where you want the file to 
go. 
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Use Single-Click Everywhere 

With single–click in Windows XP, navigating the files and folders on your hard disk is as 
easy as navigating the Web. You single-click an icon to open a program or document. 

1. In the Tools menu in My Computer, click Folder Options.  
2. In the Click items as follows section, click Single–click to open an item (point 

to select).  

Note:  To access My Computer, click Start, and then click My Computer.  You can also 
use the hotkey < >E. 

Turning AutoComplete Addresses On or Off 

The AutoComplete feature in Outlook Express in Windows XP saves you time by 
automatically completing addresses that you type when composing E–Mail messages.  
However, if you don't want to use this feature, you can easily turn it off. 

1. On the Tools menu in Outlook Express, click Options.  
2. Click the Send tab, and then clear the Automatically complete E–Mail 

addresses when composing check box. 

Change Your Wallpaper 

The graphical background of your desktop, whether it’s a picture or just a pattern or 
color, is called wallpaper.  It’s easy to change your wallpaper 

1. Right–click the desktop, and then click Properties.  
2. Click the Desktop tab, click an item in the Background list.  
3. In the Position drop–down menu, you can choose to Center or Tile the image, 

or Stretch it to cover the whole screen. 

Use a Web Graphic for Your Wallpaper 

With Windows XP, when you are on the Web and see a picture that you like for your 
wallpaper, you can easily save it and use it.  Simply right–click the picture or background 
you want to use, and then click Set as Background. 

Set Your Windows So They All Have the Same View 

If you like to see lists of your files in a certain way—as large icons, for example, or with 
detailed information—Windows XP lets you set your view options for all your folders at 
once the way you want them. 

1. On the Tools menu in My Computer, click Folder Options.  
2. Click the View tab.  
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3. Set the view for this folder the way you want it to be for all folders.  
4. Click Apply to All Folders, then click Yes to confirm, and click OK.  

Note:  To access My Computer, click Start, and then click My Computer.  You can also 
use the hotkey < >E. 

Customize the Taskbar 

With Windows XP, you can customize your taskbar so you can do everything from one 
place, including start programs, view documents, and surf the Web.  Simply right–click 
the background of the taskbar, point to Toolbars, and then click the toolbar you want to 
add: an Address bar, a Links bar, a toolbar containing all items on your desktop, or the 
Quick Launch bar. 

You can also create your own toolbar from any folder. 

1. Right–click the background of the taskbar, point to Toolbars, and then click 
New Toolbar.  Navigate to the folder you want.  A toolbar containing all items 
in that folder will be added to your taskbar.  

2. You can drag the new toolbar to any location on your desktop. You can also 
easily remove a toolbar from the taskbar by right–clicking the taskbar and then 
clicking the item again to remove the check mark. 

Show Hidden Program or System Files 

Showing hidden files can come in handy—for example, say you've tried to delete 
everything from a floppy disk and the disk properties still indicate 100K of disk space is 
being used by hidden files. 

1. On the Tools menu in My Computer, click Folder Options.  
2. Click the View tab.  
3. Under Hidden files and folders, click Show hidden files and folders.  

Note:  To access My Computer, click Start, and then click My Computer.  You can also 
use the hotkey < >E. 

Enjoy Music 

Control Audio Quality 

Windows Media Player for Windows XP lets you control the reproduction quality of CDs 
you record.  By reducing the quality, each track on your CD will take up less space.  This 
allows you to accommodate more tracks up to the 650 MB capacity of the disk.  Here's 
how: 
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1. On the Tools menu, click Options.  
2. On the CD Audio tab, move the sliding control to where you'd like it—to the 

left to create more space on each CD, to the right for the best stereo quality.  
3. Click Apply. 

Save Space on Your Hard Disk 

Concerned about your hard disk space?  Windows XP is designed to minimize the space 
on your hard disk taken up by audio recordings, and you can reduce the amount even 
more by choosing to save music at a slightly lower reproduction standard.  It’ll still sound 
great but it won’t use up as much of your hard disk. 

1. On the Tools menu in Windows Media Player, click Options.  
2. On the Copy Music tab, move the sliding control to where you'd like it—to the 

left to use the least amount of your hard disk, to the right for best audio 
reproduction. 

 

3. Click Apply.  

You can quickly glance at all the media files on your computer using the Windows Media 
Player. 
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1. Click Start, and then click Windows Media Player.  
2. Click Media Library.  
3. Click All Audio in the Media Library directory.  

You’ll see a list of audio recorded on your computer on the right side of the player.  
Double-click any file to play it.  To delete any file, right-click it and then click Delete 
from Library. 

Work With Photos 

Rotate Pictures with a Click 

What if you take a picture with the camera turned sideways to get a tall image into the 
frame?  No problem.  Use the toolbar in Windows Picture and Fax Viewer to flip the 
image right-way up. 

1. Click Start, and the click My Pictures.  
2. Double-click the picture you want to work with to launch Windows Picture and 

Fax Viewer.  
3. To rotate pictures, click the green rotation buttons on the toolbar under the 

picture. One button rotates pictures to the left, the other to the right.  

With the toolbar you can also zoom in for a closer look at any area of a photo, and 
enlarge an image to its actual size.  Simply locate the picture you want to work with in 
My Pictures, and then double-click it to start the Windows Picture and Fax Viewer. 

Do You Have an Older Digital Camera? 

If your camera does not have a USB connection, it's easy for you to manually install the 
necessary software supplied by the manufacturer to enjoy the photo features of Windows 
XP. Here's how: 

1. Click Start, click Control Panel, and then click Printers and Other Hardware.  
2. Click Scanners and Cameras.  
3. Under Imaging Tasks, click Add an imaging device.  
4. In the Scanner and Camera Installation Wizard, click Next.  
5. Click the manufacturer and model from the Manufacturer and Models lists, and 

then click Have Disk.  
6. Insert the disk containing the camera software, and then follow the instructions on 

the screen.  

If your camera is not listed in the Scanner and Camera Installation Wizard, or if you don't 
have a disk containing the software, connect the camera to the computer and try locating 
compatible software by clicking Add Hardware.  Then follow the instructions on the 
screen. 
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You can also install the software controlling your camera or scanner, especially if it is not 
a USB (Universal Serial Bus) device, by using the Add Hardware Wizard in Control 
Panel.  Afterward, connect the camera to the computer. 

Communicate 

Search for Information From the Address Bar in Internet Explorer 

You can quickly search for information on the Web using the AutoSearch feature in 
Internet Explorer 6 in Windows XP.  In the Address bar, simply type “go” or “find” or 
“?” followed by a keyword or phrase, and then press <Enter>. Your search results will 
soon appear. 

Note:  Internet Explorer searches for your word or topic using only one search service.  If 
you don't find what you need, click the Search button on the toolbar and try using 
different search services. 

Save Time and Effort in Typing URL Addresses 

With Internet Explorer 6 in Windows XP, typing Web addresses can be a breeze.  Here 
are some tips to make it even easier. 

• Type the domain of an address, such as Microsoft, and then press 
<Ctrl><Enter>. Internet Explorer automatically wraps 
“http://www....com” around what you typed.  

• Not sure if the site uses a .com extension? Just type the domain of the address, and 
then press <Enter>. Internet Explorer tries to find the site by using the various 
extensions.  

• If you need to edit an address, you can use <Ctrl><Left arrow> and 
<Ctrl><Right arrow> to easily move between different parts of the address 
separated by periods.  

Opening a Web Page in a New Window 

When surfing the Web, sometimes you might want to check out a Web page and at the 
same time stay on the page that gave you the link in the first place.  With Internet 
Explorer 6 in Windows XP, that’s exactly what you can do.  Simply press and hold down 
the <Shift> key while you click the link.  The page will open in a new Internet 
Explorer window. 

Need to look at two Web pages side by side?  That’s easy too.  To view any open 
windows side by side, right-click an empty part of the taskbar (the bar at the bottom of 
your screen), and click either Tile Windows Horizontally or Tile Windows Vertically. 
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Maintain Your Computer 

Finding Driver Information 

After you make the move to Windows XP, you may find that a piece of hardware isn’t 
functioning properly, or that your computer does not recognize it.  Making sure you have 
the right driver is a good place to start solving your problem.  A driver is a small piece of 
software that smoothes the way for your hardware to work with your computer. 

The best place to start is Windows Update 
(http://v4.windowsupdate.microsoft.com/en/default.asp).  Click 
Scan for updates in the right-hand column, and then click Driver Updates. 

If you know the specific name and version number of the driver you need, chances are 
you can download it from the Windows Update Catalog.  If you haven't already, you will 
need to turn on the Windows Update Catalog. 

1. On the Windows Update home page, click Personalize Windows Update under 
Other Options in the left-hand column.  

2. Select the Display the link to the Windows Update Catalog under "See Also" 
check box.  

3. Click Save Settings.  

A link to the Windows Update Catalog will appear in the "See Also" section of the left-
hand column.  The Windows Update Catalog lets you search for driver updates to 
hardware products, organized by kinds of product and then by manufacturers. 

Note: The Windows Update site scans your system to see what you have installed.  You 
may be asked to download software onto your computer to facilitate this process.  The 
safety and privacy of your system information is protected during this scan.  If you are 
concerned about your privacy, read the Windows Update privacy statement that is 
available on the Windows Update site. 

If you can't find the driver you need there, you can try checking the Web site of the 
manufacturer of your new hardware.  Look for information about drivers, or about the 
product you bought.  Watch carefully for links to "drivers" and keep specific information 
about your new product, such as model numbers, handy while you look.  You may need 
to call or write the manufacturer for information about whether a missing driver is your 
problem, and how you can get one. 

Important! Keep in mind that some drivers available on manufacturer Web sites may not 
have passed Microsoft compatibility testing and could harm your machine.  Microsoft’s 
Designed for Windows XP (http://www.microsoft.com/winlogo/) program 
has been created to address this problem.  For the best performance, we recommend using 
hardware products that display the Designed for Microsoft Windows XP logo on the 
external packaging and on the device itself. 
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If you try to install a driver that has not been approved for Windows XP, you will see a 
warning message.  We strongly recommend that you stop the installation process at that 
point and contact the manufacturer directly, via their Web site or by telephone or mail, 
and ask them to make Designed for Windows XP drivers available on the Windows 
Update site.  That way, you can be assured that your hardware will work properly with 
your computer, and cause no harm to your machine. 

Shopping for Computer Stuff? 

The Windows Catalog is a collection of hardware and software products that have been 
determined to work with Windows XP.  Many products in the catalog feature the 
Designed for Windows XP logo, which means they are specifically created to take 
advantage of the great new features in Windows XP and reduce the number of problems 
you might otherwise have using your computer. 

If you do not see a product in the Windows Catalog, it does not mean the product will not 
work with Windows XP.  Again, you may have to check with the product’s manufacturer 
to determine whether the product works with Windows XP. 

To find out more about the compatibility of hardware or software with Windows XP, 
search the Windows Catalog 
(http://www.microsoft.com/windowsxp/pro/howtobuy/upgrading/c
ompat.asp). 

Some Straightforward Talk on Virus Prevention 

Computer virus threats often sound alarming, but some common sense and a dose of 
protection will help you ward off even the most malicious Internet illnesses. 

Protect yourself now.  Here are some easy–to–follow rules to reduce your chances of 
suffering the consequences of a virus: 

• Always use up–to–date anti–virus software on your system.  
• Keep your anti–virus program updated to stay ahead of any new viruses.  
• E–Mail itself cannot infect your computer, but if you open an infected attachment 

in E–Mail, it can infect your computer.  Therefore, you should turn off any 
features that automatically open E–Mail attachments or launch programs you 
download.  

• Create an emergency boot disk for your computer and write–protect it in case you 
catch a virus that affects your computer's start–up ability. 

Stay Up to Date Automatically 

Automatic updates in Windows XP ensure that your computer is always current.  
Windows XP checks Windows Update for the latest updates whenever you are on the 
Internet, determines which updates apply to your computer, and downloads them in the 
background while you keep working or playing.  If you prefer, you can have the 
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computer continue notifying you with automatic balloon message reminders about 
updates.  It’s up to you! Here's how. 

• Click Start, click Control Panel, click Performance and Maintenance, and 
then click System.  

• On the Automatic Updates tab, click the setting of your choice.  

Note:   If you choose not to use automatic updating, you can always install specific 
updates from the Windows Update (http://windowsupdate.microsoft.com/) 
Web site whenever you like. 

Help Save Energy and the Environment: Put Your Monitor to Sleep 

You can save electricity and money and help protect the environment by activating your 
monitor's "sleep" feature in Windows XP.  Activating sleep settings on just one computer 
prevents approximately 300 pounds of CO2 emissions each year.  

Putting your monitor to "sleep" means allowing it to go into a low-power mode when 
you're not using it.  To "wake" your monitor, you simply touch your mouse or keyboard. 

1. Click Start, and then click Control Panel.  
2. Double-click the Display icon.  
3. Click the Screen Saver tab.  
4. In the Monitor Power box, click the Power button.  
5. In the Turn off monitor box, select After 10 mins, or choose a time that you 

find appropriate.  


